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SECTION 1  
ABOUT THIS MANUAL 
 

Introduction 
 
This manual is a software reference for the features of the Pryor Markmaster 
software when operated with dot peen marking machines controlled using the 
Marktronic 3000 series controller.  
 
For specific details about the machine itself please refer to the user guide supplied 
with the machine.  
 
The 3000 series controller (pictured below) is capable of controlling many different 
models of dot peen machine in a variety of control modes.  
 
Normally the controller is configured to ‘Embedded LCD mode’. In this mode the 
marking layouts are created using the controllers LCD screen and membrane 
keyboard via a series of on-screen menus. Full details of this mode are covered in 
the user guide supplied with the machine. 
 
 
 
 
 
 
 
 
 
 
 
 3000 Controller   ‘Embedded LCD’ Menu Screen 
 
 
This manual is for the Markmaster Windows software which may be used as an 
alternative method for controlling the dot peen machine. When using Markmaster, 
the 3000 controller is still used but all user interface control is performed via the PC 
software. When using Markmaster the controller needs to be configured to ‘Windows 
Interface’. See the getting started section to learn how to switch the controller in to 
‘Windows Interface’ mode.  
 
The 3000 controller connects to the PC via an RS232 connection, using a null 
modem serial cable. 
 
The MarkMaster™ software is primarily used to create marking layouts such as text 
and graphics. These can then be dot peen marked directly on parts by clicking the 
Mark button in the software.  
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The Markmaster software has a configurable marking area to suit the machine it is 
connected to, allowing a wide range of marks to made, including straight text, angled 
text, arc text, various high speed matrix fonts as well as Windows True Type font 
support for decorative, high quality marks.  The software can automatically generate 
serial numbers, time / date marks as well as interface directly to database systems. 
 
The MarkMaster™ software includes but is not restricted to the following list of 
features. 

• Full graphical user interface 
• Angle and Arc Text Marking (5x7, 7x9 and Varidot Fonts) 
• Time / Date, Shift Coding and Serial Number Marking 
• Variable data input features 
• Advanced Trial Run with cursor jog features 
• Marking Depth control 
• Dot Spacing Control 
• HPGL / DXF logo marking 
• Shape tools for marking  
• True Type Font marking 
• Database connectivity tools 
• Layout Offsets 
• Advanced Serial Number features 
• Programmable Z Axis control (where fitted) 
• Circumferential Marking control (where circumferential axis is fitted) 
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SECTION 2  
GETTING STARTED 
 

PC Minimum Requirements 
Please ensure the selected PC meets these minimum requirements. 
 
Windows 2000/XP or Vista 
Spare RS232 Serial Port 
1GHz Processor 
512Mb RAM 
60Mb available HD 
 

Configuring the 3000 Controller 
 
The 3000 controller needs to be running in ‘Windows Interface’ mode when working 
with Markmaster. If your controller screen looks similar to the screen below (i.e 
Windows PC Interface screen title), skip this section and move on to ‘Setting up the 
PC’. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
To switch the controller to Windows PC interface follow the steps below. 

1. Switch off the controller and switch it back on holding down the F9 key. 
2. When prompted to enter a password enter “PRIORITY UPGRADE” and press 

Enter. 
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3. The machine configuration screen below will be displayed. 

 
4. Change the Mode to Windows Interface using the left and right cursor keys, 

then press ESC. The controller will re-boot into Windows Mode and display a 
screen similar to the photo in the previous page. You are now ready to set up 
the PC. 

 
 

Setting up the PC 
 
 

1. Insert the CD into the CD/DVD drive or your Windows 2000/XP/Vista PC. The 
installation should automatically begin. If not, browse to the CD drive in ‘My 
Computer’ and run the setup.exe file then follow the installation instructions. 
When asked to select the marking devices, select LCD 3000 series if your PC 
is connecting via RS232 to a 3000 style controller.  

 

 
   
 Then select LCD 3000 Series as the default device on the next screen. 
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2. The MarkMaster software requires the Microsoft .Net Framework to be 

installed on the PC. If this is not installed the installation program will guide 
you though the process. 

3. When the software installation is complete, connect the 3000 controller to the 
PC using the RS232 null modem cable supplied (Details at rear of manual). 
Connect to Port A on the controller and make a note of the Com port used on 
the PC. Normally it is Com1.  

4. Now run the MarkMaster software from the Windows Programs Menu. 
a. Start->Programs->Pryor Marking Technology->MarkMaster 

5. The MarkMaster opening screen displays the status of the machine 
connected. 
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If the screen is as above. “LCD3000 Series device found”. Then the 
connection is working. Go to the next step. 

 

 
 

If the screen is “LCD 3000 Series not found” then click OK and select Device 
Settings from the Mark menu. 

 
Select ‘Controller’ in the tree view and select the Com port on the PC which 
the 3000 controller is connected to. Ensure the Baud rate is set to 19200. 
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Click Close and restart the software. If Markmaster fails to find the controller 
this time. Please consult the trouble shooting guide for further information. 

 
 

6. The software is now installed and ready to be configured for your actual 
machine. The main settings which need to be configured are the marking area 
of the machine and the steps per mm of the marking head. To do this select 
Device Settings from the Mark menu.  

 

 
 

Select ‘XY Settings’ in the tree view as below. 
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Enter the X and Y Limits of your marking head and also the steps per mm 
value. The table below will show you the settings for each model of machine. 

 
Machine X Limit Y Limit Steps per mm 
Portable Machines    
PortaDot 50-25E (LD2) 50 25 29 
PortaDot 130-30E 130 30 16 
PortaDot 130-40E 130 40 13 
PortaDot 100-75E (HD2) 100 75 33 
Bench Top Machines    
BenchDot 60-60E 60 60 40 
BenchDot 100-100E 100 100 40 
BenchDot 150-150E 150 150 40 
BenchDot 300-150E 300 150 40 
Integrator Machines    
InDot 50-25E 50 25 29 
InDot 60-60E 60 60 40 
InDot 130-30E 130 30 16 
InDot 130-40E 130 40 13 
InDot 150-150E 150 150 40 

 
 

7. If you have a 3000 series BenchDot machine with an electric Z axis then click 
on ‘Z Axis Settings’ and enter, otherwise skip to the next step. 
 

Enabled = True 
Proxy = PNP 
Steps Per MM = 67 
Type = Electric 
Z Limit = 375mm 
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If your machine has an autosense module fitted you need to enable the 
Autosense here and enter your slug offset value. A good starting point is 
2mm. 

 
 
If you have a 2068 series machine your Steps per mm should be 133 and 
your Z limit is normally 240mm 
 
8. Click Close and Restart the Markmaster software so the changes take 
effect. When the ‘Marking Devices Available’ screen is displayed, click ok. 
You now have a blank layout which should be the same size as your 
machines marking area. You are now ready to start creating and marking 
layouts. 

 
 

Unlocking the Markmaster software on your PC 
When Markmaster is initially installed, it installs as an evaluation version of the 
software. In evaluation mode the software is completely unrestricted for a period of 
28 days.  
 
During the first 28 days you will need to contact your distributor or Pryor for an 
unlock number which will unlock the software to your specific PC. It is advisable to 
only do this once the software is installed on the actual PC you intend to use the 
machine on for the long term. When the software is run the ‘Marking Devices 
Available’ screen will show the number of days left and also the serial and product 
numbers. You must supply these two numbers when requesting your unlock number.  
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Note : The product and serial numbers are unique to each PC so only request the 
unlock details from the PC you intend to use in the long term. 
 
Once you have your unlock number, go to the Options in the Tools menu. 
 

  
 
Then click on Devices. 
 

 
 
 
Select the LCD 3000 Series device. You can then enter your unlock key on the 
screen and click Unlock. If the unlock code is correct your software will be 
permanently unlocked on your PC. 
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SECTION 3  
LAYOUTS 
 
To produce any kind of mark a MarkMaster layout must be created. A layout 
contains information about the Text to be marked, its Font, its Size, Force, XY 
position and various other settings relating to the mark appearance.  
 

Creating and marking a layout – Quick Start Guide 
 
The screen below shows a new layout in MarkMaster.  

 
 
The software can be controlled using the menus and menu items or the toolbar 

buttons below the menu. To place some text in the layout click the  button or 
select Markable Objects->Text from the Insert Menu. 
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This inserts the ‘Sample Text’ text on to the marking area.   
 

 
 
The text object can be selected and manipulated using the mouse. When any layout 
object is selected either from the marking area or the marking sequence, its 
properties are displayed on the bottom left pane of the screen. The properties may 
be modified by clicking them with the mouse, entering a new value and pressing 
enter to update the screen. Other properties such as X & Y position, height, width 
and angle may also be changed directly using the mouse on the object directly in the 
marking area. 

Marking Sequence 

Marking Area / 
Graphics Area 

Inserted Text  
to be marked 

Selected Text 
Properties 
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Trail Run of the mark 
It is possible test the position of the mark on the actual part to be marked using the 
‘track moves’ and ‘outline object’ features. To try this place a test piece under the 
marking head and adjust the gap between the stylus and the workpiece  

Select the ‘Sample Text’ Text Object on the marking layout and press the  button 
on the tool bar to move the marking head to the top left corner of the text object. The 
marker will now track all moves made on that text object on screen as well as on the 
part itself. The position may be modified by dragging the object with the mouse or 

using the cursor keys. To move the marker around the outline of the text click the  
button on the toolbar. 
 
Marking the layout 

Once the object is in the required position for marking, click the  button on the 
toolbar to display the marking dialog. 

 
 
Click Start and the marker will mark the text on the part. The Stop button on the 
screen may be used to stop the marker should this be required. When the mark is 
complete click the X in the top right corner to close the marking dialog and return the 
layout editing screen. 
 
Adjusting the Mark Settings. 

The mark depth may be modified using the Mark Settings tool. Click the  toolbar 
button this adds the Mark Settings tool to the marking sequence area of the screen. 
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Select the Mark Settings with the mouse and drag it above the Text Object as below. 
 

 
 
Then change the mark settings to suit the depth of mark required. 
 

 
 
The example above changes the Force from the default value to a force of 4. The 
marking force can vary from 0 – 9. 0 is no mark and 9 is a deep mark. The gap 
between the stylus and work piece also affects the depth of the mark. 
 
If several markable objects are to be marked at different mark settings, these can be 
grouped together in the mark sequence and several mark settings added. All 
markable objects below the mark setting tool will be marked with those settings until 
another mark setting tool is encountered in the sequence. 
 

Saving a layout 
 

To save a layout so that it may be used later, click the  button on the toolbar. This 
displays the Windows File Save Dialog. 
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Enter a filename e.g ‘Example Mark’ and click save. The layout is now saved to the 
PC hard drive. In the example above the layout is saved to the My Documents folder. 
 
  

Loading a layout 
 
Once a layout has been saved it may be loaded at a later date. To demonstrate this 
close the layout using the lower X button in the top right corner of the screen. 
 

 
 

Then click the  toolbar button to display the Windows file open dialog. 
 

Close Layout 
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Browse to the location of the saved file, select it and click the Open button. The 
layout is then loaded into the software. 
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SECTION 4  
Adding Objects to Layouts 
 
Objects can be created using either the Toolbar or the Insert menu. 
 

Creating Objects using the Tool Bar 

 
 
The Toolbar is a quick way to create new markable objects within the current layout.  
Some of the more commonly used types of objects and the corresponding toolbar 
buttons are shown below. 
 

   Creates a Text Object within the layout. 

   Creates an Arc Text Object within the layout. 

 Creates an Imported Graphics File Object within the layout.  

 Creates a Shape within the layout. 
 
When a new object is created using the toolbar, it is placed at the next free position 
in the marking sequence area of the screen.  Once it is placed in the layout it can be 
edited by selecting it in the marking area.  The object can also be moved by clicking 
it in the Sequence area of the screen and dragging to change its position in the 
marking sequence. 

Creating Objects using the Menu  
The Insert menu contains all the objects for inserting as part of a marking layout. 
Selecting one of these creates that object within the marking layout.   
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The Text Objects   

The most commonly used markable object is the Text object .  It is used for 
marking any type of text, be that static text or variable text. The Text object has 
many editable properties, changing these affects the way a piece of text is displayed 

and marked.  Another commonly used markable object is the Arc Text .  This is 
used for marking any type of text that is to be marked in an arc on a flat workpiece.  
A full description of each property is given below. 
 
. 

Text Properties  
 
The text properties are displayed when a text object is selected 

  
 

Text 
 

The Text Object holds the actual text to be marked.  Static text (text which will 
always remain the same within a layout) should be entered directly into this 
property. Any changes to this property will be reflected in the graphical view 
when enter is pressed or when the mouse is clicked away. The text property 

also has a …  button which displays the Text Editor dialog for configuring 
variable text. See the Variables section for further details.  The Text Object 
has the following properties assigned to it. 
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Note: You must click the mouse on the Text property for the  button to be 
displayed.   

 

Font 
 
The font property is a drop down menu that lists all the currently installed 
fonts.  

 

Maintain Aspect 
 

The Maintain Aspect property keeps the proportions between width within a 
specified text width window.  Simply select Yes or No from the drop down 
menu within the Maintain Aspect edit field.  If No is selected then the text will 
be re-sized to fill the specified text width window. 
 

Dot Spacing 
 

The Dot Spacing property affects the distance between dots when the marker 
is marking the following objects. 

• Varidot Font 
• True Type Fonts 
• Shape Objects 
• Imported Graphic Objects 

Changing the dot spacing to a smaller value will give the impression of a solid 
continuous line when marked as the dots will be placed on top of each other. 
The marking cycle time will increase the smaller the Dot Spacing value is. The 
example below shows the dot spacing at 0.8 and 0.4. 

 
Alignment 
The Alignment property is used to specify how the text should be aligned within its 
bounding box. The text can either grow or shrink in length from the Left, Centre or 
Right. The example below demonstrates this. 

 
 

Bold 
The bold property applies to true type fonts and when marked gives a bolder look to 
the characters. 
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Italic 
The Italic property applies to true type fonts the example below shows the italic 
effect. 

 
 

Mirrored 
The Mirrored property marks the text in a mirrored format. This can be useful if 
marking on thin sheet to produce an embossed effect. 

 

 
Spacing 
 

The spacing property is used to add extra spacing between characters 
(default value is set to 1).  The example below shows the spacing property set 
to 2; notice the increase in spacing between the characters. 
 

 
X (mm) 

The X (mm) position property displays the current position of the object on the 
horizontal or X plane within the layout. It is possible to adjust this value 
directly by entering a known position into the X position edit box or by 
graphically moving the object by ‘dragging’ the mouse. 

Y (mm) 
The Y (mm) property displays the current position of the object on the vertical 
or Y plane within the marking layout. It is possible to adjust this value directly 
by entering a known position into the Y position edit box or by graphically 
moving the object by ‘dragging’ the mouse. 
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Width Property  
The Width property displays the overall width of the text to be marked. This 
value should be changed to stretch or condense the text. The width property 
can also be changed by graphically dragging the mouse on the width handle 
of the text object. See also the Use Minimum Width option when changing the 
Width property. 
 

Height Property 
The Height property displays the character height of the text to be marked. 
This value should be changed to stretch or condense the height of the text. 
The height property can also be changed by graphically dragging the mouse 
on the height handle of the text object. 
 

Angle (deg) 
The Angle property is used for setting the rotation angle of the object 0 – 360°. 
The object is rotated with respect to the objects origin. It is also possible to 
change this value graphically by dragging the mouse on the rotation handle of 
the object.  In the example below the angle is set to 10°. 
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Arc Text  

Arc Text Properties 
The Arc Text Object shares many of its properties with the Text object. The 
following properties are specific to the Arc text object. 
 
The Arc property is used to form text around an arc. 

 
 

Align to Inner Diameter 
The Align to Inner Diameter property is used to align the arc text to the inner 
diameter (by selecting Yes from the drop down menu in the select field) or to 
the outer diameter (by selecting No from the drop down menu in the select 
field).  An example of each is given below. 
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The Vector Drawing Object  
The Vector Drawing Object is used to allow graphical objects (HPGL logo’s and 
vector drawings) to be imported into MarkMaster for marking. Complex drawings or 
logos can be imported from many drawing and CAD packages. The File formats 
supported by MarkMaster are. 
 
� HPGL 1&2 (*.plt) 
� AutoCAD DXF Revision 12 (*.dxf)  
 

To import a file click on the Insert Vector Drawing  icon, this displays the 
Windows File Open dialog as below. 

 
 

 
When the desired file is selected, Click Open and the object will be imported into the 
marking layout.  
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Note:  When a layout is saved only the file path to the object is saved not the object 
itself. Always ensure that the imported graphics files remain at the locations pointed 
to within the marking layouts. 
 
An Imported Graphics File Object has the following Properties available. 
 

 
 
 

X (mm) 
The X (mm) position property displays the current position of the object on the 
horizontal or X plane within the layout. It is possible to adjust this value 
directly by entering a known position into the X position edit box or by 
graphically moving the object by ‘dragging’ the mouse. 
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Y (mm) 
The Y (mm) property displays the current position of the object on the vertical 
or Y plane within the marking layout. It is possible to adjust this value directly 
by entering a known position into the Y position edit box or by graphically 
moving the object by ‘dragging’ the mouse. 

Width Property 
The Width property allows the width of the vector drawing to be modified.  

Height Property 
The Height property allows the height of the vector drawing to be modified. 

Angle (deg) 
 The Angle property allows the vector drawing to be rotated to any angle.  

Filename 
The Filename property allows the path to the graphic file to be changed to an 
alternative location by entering it directly or clicking on the … browse button. 

Dot Spacing 
The Dot Spacing value allows the distance between the dots to be modified. 
Reducing the dot spacing can produce marks with continuous lines but this 
can affect the marking cycle time. It is worth experimenting with this value to 
obtain the optimum quality/cycle time compromise.  
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The Shape Object  
The Shape Object provides a simple graphics tool for drawing triangles, squares, 
rectangles and circles for marking. The example below uses several shape objects 
to create a label template which can be marked directly onto a part, providing a label 
look without the label. 
 

  
 

 
 

X (mm) 
The X (mm) position property displays the current position of the object on the 
horizontal or X plane within the layout. It is possible to adjust this value 
directly by entering a known position into the X position edit box or by 
graphically moving the object by ‘dragging’ the mouse. 

Y (mm) 
The Y (mm) property displays the current position of the object on the vertical 
or Y plane within the marking layout. It is possible to adjust this value directly 
by entering a known position into the Y position edit box or by graphically 
moving the object by ‘dragging’ the mouse. 

Width Property 
The Width property allows the width of the shape to be modified.  

Height Property 
The Height property allows the height of the shape to be modified. 
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Angle (deg) 
 The Angle property allows the shape to be rotated to any angle.  

Sides 
The Sides property allows the shape of the object to be defined. For example 
to mark a square or a rectangle specify 4. To mark a triangle 3 and to mark a 
circle specify 20+. 

Dot Spacing 
The Dot Spacing value allows the distance between the dots to be modified. 
Reducing the dot spacing can produce marks with continuous lines but this 
can affect the marking cycle time. It is worth experimenting with this value to 
obtain the optimum quality/cycle time compromise.  
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The Mark Settings Tool  
The Mark Settings Tool is used to change the marker settings within the marking 
sequence. Primarily this is used to change the depth of the mark on the material of 
the part being marked. If the material is a soft aluminium a lower force and smaller 
stylus to work piece gap should be used. If the material is hardened steel then a 
larger gap and higher force should be used. Also the dot spacing used on a 
markable object plays an important role in the appearance of the mark. 
Experimenting with different spacing and force settings on different materials will 
soon provide an understanding of the machines capabilities. 
 
Several Mark Setting Tool Objects may be used in a marking sequence especially if 
marking Dot 5x7 fonts and Shape or Vector Drawing objects in the same layout. 
Simply drag the Mark Setting tool above the markable objects which require those 
mark settings. The software will process the Marking Sequence in order and 
therefore set the mark settings, then mark objects below at those settings until a 
different mark setting tool is encountered 
 

 
 

Dot Display Size 
The Dot Display Size property allows the size of the dots in the marking layout area 
of the screen to be changed. If your application is marking at a low force with small 
characters it is often useful to reduce the size of the dots on screen to give a clearer 
preview of the mark. This is demonstrated below. The Dot Display Size on these two 
Text Objects is 0.3 and 0.5 respectively. 
 

 
 
 
 

Force 
The Force property allows the depth of the dots in the material to be adjusted. The 
higher the force the harder the stylus impacts onto the part. The force ranges from 0 
– No Mark to 9 – Deepest Mark. 
 
Note : The gap between the work piece and the stylus also impacts on the depth of 
the mark. Increasing the gap also increases the depth. Typical marking gaps are 
between 1 – 5mm. 
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Repeat Dot 
To obtain even deeper marks it is possible to repeat each dot up to 3 times. Use the 
Repeat dot property to achieve this. 
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SECTION 5  
SERIAL NUMBERS AND VARIABLES 
 

Serial numbers 
 
Introduction 
Serial numbers automatically increment or decrement after a layout has been 
successfully marked.   Serial numbers can consist of numbers or letters, the actual 
sequence they follow can be defined if the standard 0000-9999 configuration is 
inadequate. 
 
There are two kinds of serial numbers, global and layout. 
 
Global serial numbers 
A global serial number is unique, it increments by 1 every time that it is marked. If 
the global serial number is specified for example, in 5 places in a layout then the 
layout will mark 5 sequential numbers.   The global serial number is shared by all 
layouts.    
Layout serial numbers 
Each layout has its own serial numbers.   They are stored with the layout.   Layout 
serial numbers may increment or decrement by specified amounts after a specified 
number of marks have been completed.   The configuration of each layout serial 
number may be specified individually. 
 

The Serial Number Object  
The Serial Number Object allows layout serial numbers to be added to a marking 
layout. When the Insert Serial Number button is pressed on the toolbar the Serial 
number Object is added to the Serial Number section above the Marking Sequence. 
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Selecting the Serial Number object displays its properties below. 
 

Digits 
The Digits property specifies how the serial number counts. The default value is 
‘0123456789’. This means that when the end digit reaches 9 it loops back round to 
zero and continues counting. If the digits property was set to ‘0123456789ABCDEF’ 
then it would reach 9 and then continue to A, then B etc until F when it would then 
loop round.  (i.e. it would count in hexadecimal) 
 

Increment By 
The Increment By property specifies by how much the serial number should count up 
by after it is marked. The default value for this is 1. 
 

Increment Every 
The Increment Every property specifies how often the serial number should 
increment. This is useful if 3 parts need to be marked with the same serial number. 
Setting the Increment Every property to 3 will then mark 3 parts before incrementing 
the serial number. 
 

Name 
The Name property allows each serial number in a layout to be given a meaningful 
name. This is useful later when the serial number needs to be inserted in to the 
layout for marking. 
 

Number of Digits 
The Number of Digits property is useful for specifying how many leading zeros 
should be marked for a serial number. For example if the Digits is set to 5 and the 
serial number value of 3 is entered. Then the marker will mark 00003 to make it up to 
5 digits.  The digits property is also useful for specifying a roll over value. For 
example, if the digits is set to 2. Then when the marker marks 99 it will roll over to 
01. 
 

Reset 
The Reset property allows serial numbers to be reset on certain events. The options 
available are:- 

 
Therefore it is possible to reset the serial number to 00001 (if digits are set to 5) 
when the Day changes, Week Changes, Month Changes, Year Changes or Shift 
Code changes. 
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Marking a Serial Number 
When the serial number is given a meaningful name and its properties are 
configured, it can now be added to the marking layout so it can be marked. To do 
this we must ‘link’ it to a text object. Follow the procedure below to do this. 
 

1. Configure the Serial Number and give it a name of ‘My Serial’ 

2. Insert a Text Object into the layout by clicking the  button. 

3. Select the Text object and click the  button on the Text Property. 

 
4. This displays the Text Editor Dialog. 

 
 
5. Select the ‘Sample Text’ and delete it. Then select ‘My Serial’ from the 

Variable Tab and click Insert.  
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6. Then click OK. The serial number will now be displayed within the text object 
on the layout. 

  

The Global Serial Number Object  
The Global Serial Number object allows global serial numbers to be added to a 
marking layout. The global serial number object may be shared across several 
layouts to ensure only unique serial numbers are marked across a range of different 
parts. 
 
The Global Serial Number shares the same properties as the standard Serial 
number (See Previous Section). The only difference is that the same serial number 
name can be used in other layouts and the globally stored value will automatically be 
used every time that global serial number is referenced in a layout. 
 
Several Global Serial numbers may be created if required. 
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Variables 
 
Introduction 
Variables enable text objects to be changed without having to edit the whole layout.   
When the variables are edited prompts can be displayed so that the operator knows 
what each variable is. 
 
There are two kinds of variables, global and layout. 
 
Global variable 
A global variable is shared between all layouts. Therefore it only has to be changed 
once for this to affect all layouts which use it.  
 
A global variable could be used to hold an inspector’s initials which would then be 
incorporated in all layouts marked by that inspector, for example. 
 
Layout variables 
Each layout has its own variables.   They are stored with the layout.   A Prompt may 
also be specified, as a reminder of what each variable is when the variables are 
edited. 
 

The Variable Object  
Variables hold information to be marked separate from the text objects themselves. 
The simplest use of a variable would be if the same piece of text is marked in several 
places in a layout. The variable could contain the text to be marked, and all the text 
objects in the layout could be ‘linked’ to it. Then to change the text being marked 
across the whole layout would only require the variable to be changed, all the objects 
linked to it would then change automatically. 
 
To demonstrate this, follow the procedure below. 
 

1. Create a new layout. 

2. Add 3 Text Objects by clicking the  button 3 times. Then position the 
Sample Text objects so they can be clearly seen on the screen. 
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3. Now click the Variable button to add a Variable above the marking sequence. 

 
 
4. Name the Variable ‘My Variable’ by selecting it in the Mark Sequence and 

changing its Name property from ‘No Name’ to ‘My Variable’. Then give the 
Variable a Value of ‘ABC123’ this is the text which will be marked. 

5. Then select the first text object and click the  button on the Text property. 

 
6. In the Text Editor dialog, delete the ‘Sample Text’ text, select the ‘My Variable’ 

variable in the list and click Insert. Then Click OK. 
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7. Repeat this for each text object. Then all 3 text objects are linked to the one 

variable. If you change the variable all 3 text objects also change. 

 
 
 

The Global Variable Object  
Global Variables operate in exactly the same way as normal Variables (see previous 
section) except they may be used across a number of layouts. The value of the 
Global variable is stored globally in the software, so whenever it is edited all other 
layouts which use it are also updated. When using the global variable in multiple 
layouts ensure a global variable is added to the layout and the same name is given 
across the layouts it is used in, otherwise it will not use the same value. 
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The Set Variable Value Object  
As demonstrated earlier in this section Variables are basically a way of storing text to 
be marked in a single place which may then be linked to text objects for marking. Up 
until now the only way to modify the variable value has been to select it in the 
marking sequence and edit the value directly. 
 
The Set Variable Value Object provides other ways of modifying variable values. 
 
The simplest method is to prompt the user to enter specific details at the time of 
marking. This can be done using the ‘Use Prompt’ and ‘Message’ properties of the 
Set Variable Value object. 
 
To demonstrate follow the procedure below. 
 

1. Create a new layout and insert one variable (click ), one Set Variable 

Value object (click ) and one text object (click  ). 

 
  
2. Ensure the Set Variable Value object is above the Text Object, click and drag 

it above if it is not. 
3. Select the Variable and Name it ‘My Variable’ and give it an initial value of 

‘123’ 

4. Link the Text object to the ‘My Variable’  using the  button on the text 
objects Text property. (See previous section for details on this.) 

5. Select the Set Variable Object and change the Message property to ‘Please 
Enter the Part Number’ and change the Use Prompt to ‘Every Mark’. 

6. Set the Name property in the Set Variable Object to ‘My Variable’. This tells 
the Set Variable Object which Variable it is modifying. 



 Markmaster user guide 

 

 5-9 

 

7. Now place some test material under the marker and click the  button to 
open the mark dialog. Then click Start.. The software will now prompt for the 
Part Number to be entered. 

 
8. Enter a different value eg. ‘321’. Once entered the part will be marked with 

this value. 
 
If several variables are in the layout then several Set Variable Value objects can 
also be inserted. This allows the software to prompt for several values to be 
entered before the marking commences. 
 
A barcode scanner could also be connected to the PC to allow details from a 
barcode to be scanned in to prevent the risk of typing errors.   
 
Note: It is important that the Set Variable Value object is above the text object to 
which it is ultimately linked otherwise the value may be modified after it has 
already been marked. 

  

Enable Barcode 
The Enable Barcode property may be set to True if an RS232 barcode scanner is 
attached to the PC. The scanner should be configured to transmit in the format. 
 
<STX>data<ETX> at the RS232 settings below. 
 
Baud Rate – 9600 
Data Bits – 8 
Parity – None 
Stop Bits – 1 
 
If using a keyboard wedge type scanner (these normally have PS/2 or USB 
connectors) then the Enable Barcode can be left at False as these types of scanner 
simulate the PCs keyboard. 
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Message 
The Message property is the message displayed to the user when the software 
prompts for the variable value to be entered. In the Example below the Message 
property was set to ‘Please Enter Part Number’. 

 
 

Use Prompt 
The Use Prompt defines whether the Set Variable Value object prompts the user for 
information to be marked. Setting this to None, disables the feature, setting it to 
Every Mark allows the software to prompt for information on every mark and the On 
Request Option allows the details to be updated only when requested by the user. 
 
To request to update the variables the user should press the ‘Set Variables’ button 
on the Marking Dialog. This is useful if the details only change at the start of a batch 
of marking. Then the user is not prompted continuously to modify the variables. 
 

Name 
The Name property is a drop down box showing all variables in the layout. Simply 
select the variable to be modified with this property. 
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SECTION 6  
TIME AND DATE FUNCTIONS 
 

Introduction 
 
Markmaster can mark a variety of time and date information based on the PCs real-
time clock.   This information can be incorporated into a layout in several different 
ways. 
 
The following commands can be typed directly into a text object, alternatively they 

can be selected from the Text Editor dialog which is accessed using the  button on 
the Text Property of the Text Object.  
 

 
 

To add time and date commands using the Text Editor dialog click the  button on 
the text object. This displays the dialog below. 

Command Value 

[HOUR] Hour 0-12. 
[0HOUR] Hour 00 – 12 (2 Digit) 
[HOUR24] Hour 0-23 
[0HOUR24] Hour 00-23 (2 Digit) 
[AMPMTEXT] AM/PM Text 
[AMPM] 0 – AM, 1 – PM 
[MINUTE] Minute 0-59. 
[0MINUTE] Minute 00 – 59 (2 Digit) 
[SECOND] Second 0-59. 
[0SECOND] Second 00 – 59 (2 Digit) 
[SHORTTIME] HH:MM 
[LONGTIME] HH:MM:SS 
[MONTHDAY] Date 1-31 
[0MONTHDAY] Date 01-31 (2 Digit). 
[MONTH] Month 1-12. 
[0MONTH] Month 01-12 (2 Digit) 
[MONTH0] Month 00-11 Month Number starting at zero 
[MONTHTEXT] January - December 
[MONTHTEXTABB] Jan - Dec 
[YEAR] Year 2000 - 2099. 
[SHORTDATE] DD/MM/YYYY 
[LONGDATE] DD/January-December/YYYY 
[YEARDAY] 001-365 
[WEEKDAY] 1- Monday, 7 - Sunday 
[WEEKDAYTEXT] Monday - Sunday 
[WEEKDAYTEXTABB] Mon - Sun 
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Select the Time tab and select the time / date option required, press Insert and OK 
and the option is added.  
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SECTION 7  
ADDITIONAL FEATURES 
 

Home position 
 
The marking head has a fixed XY axis home position, normally at the top left corner 
of the marking area.   This position is sensed by two proximity switches.   The 
marking head will return to this position before and after a layout is marked.   This 
ensures that marks are produced in the same place every time.   The XY positions of 
marks are normally specified relative to this home position, unless offsets are 
defined. 
 
The Mark Dialog has a home button, this can be used to manually home the 
machine. 
 

Offsets 
X and Y offsets can be programmed to the layout. This can be a useful feature if you 
are marking batches of parts a distance from the home position. If you program an X 
offset of 20.00mm and a Y offset of 30.00mm then the marker will move to that 
position at the end of the mark rather than return all the way home. 
 

Trial Run / Track Moves 
MarkMaster allows individual markable objects to be positioned directly on to the part 
using the track moves feature. The easiest way to use the feature is to select an 
object in the marking area and right click the mouse on it. This displays the context 
menu. 

 
 
Selecting Track Moves allows the marker to move to the top left position of the object 
selected. Moving the object with the cursor keys or mouse will cause it to move on 
screen and on the marker also. To trace around the object on the part select Outline 
Object or press F8.  
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The distance the cursor keys jog the object is adjustable by setting the grid 
resolution.  

 
 
The Grid resolution toolbar has the following settings. 
 

• Snap to Grid 
• Grid Resolution Automatic (Based on the Zoom Level) 
• Grid Resolution 10mm 
• Grid Resolution 5mm 
• Grid Resolution 1mm 

 
When the grid resolution is 10 mm the jog step for each cursor press is 1mm, when 
the grid resolution is set to 5mm the jog step is 0.5mm and when it is set to 1mm the 
jog step is 0.1mm. 
 
When you are finished aligning the objects to the parts, select Track Moves again to 
send the marking head home. 
 
 

Show Dot Path 
The marker moves from Dot to Dot when marking a layout. It is possible to view the 

actual marking path that will be taken by toggling the Show Dot Path button . 
Below is an example of this feature. 
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SECTION 8  
DATABASE CONNECTIVITY  
 
The MarkMaster software features various powerful database connectivity tools, 
allowing the software to query data from and write back to various database 
systems.  
 
Supported Databases at Version 1.11. 
 

• Microsoft Excel Speadsheets (*.xls) 
• Microsoft Access Databases (*.mdb) 
• SQL Server 
• MySQL 

 
There are 4 layout objects which relate to the database connectivity features. 
 

Connection Object 
The connection object can be inserted into a layout by selecting Insert->Database-
>Connection from the menu. This adds the Connection object to the layout. 
 

 
 
The connection object is used to tell the software which database to connect to and 
where the database is located. It is possible to have multiple connections to multiple 
types of database in a single layout if required. 
 
Database Type – The first action when configuring the software is to select what 
type of database the software is connecting to. This property has a pull down box 
showing the supported database types. 
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Data Source – This is the location of the database file or server. If using Access or 
Excel files use the browse button to find the location of the file when the Data Source 
property is selected. 
 
Name – The default name is ‘Connection 1’. This is simply the name used to define 
the connection. It is used when querying the database and can be useful if 
connecting to multiple databases. If only connecting to a single database then you 
can leave this name ‘Connection 1’. 
 
Password & User Name – If the database file is security protected then enter the 
username and password in these properties. Otherwise leave blank. 
 
Use Header Row – If connecting to an Excel spreadsheet the ‘Use Header Row’ 
should be used to define the names of the columns in the spreadsheet. In the 
example xls file on the following page ‘Serial’, ‘Data’ and ‘Marked’ are all on the 
Header row and will be used in any Queries to that spreadsheet. It is therefore 
important to format all excel spreadsheets to have the column names on the top row 
of the spreadsheet. 
 
Unique ID and Unique name – These properties are used by external programs 
and do not need to be modified. 
  
Using the Database Test Dialog to test the connection. 
The Database Test Dialog is a useful tool to diagnose and test any database 
connections. To open the dialog select Tools->Database Test Dialog from the menu. 
 

 



 Markmaster user guide 

 

 8-3 

The same connection properties described previously are displayed on the 
Connection tab. The connection can be tested by clicking the ‘Test Connection’ 
button. If successful the following message is displayed. 
 

 
 
 
 

Query Object 
The Query object can be inserted into the layout by selecting Insert->Database-
>Query from the menu. This adds the Query to the layout. 
 

 
 
The Query object is used to get data from the database. It uses standard SQL 
(structured query language) statements to retrieve the data. SQL is a very powerful 
language, this manual will cover just the basics such as returning data from an 
Access or Excel table. For further in depth knowledge of SQL see… 

 http://www.geocities.com/SiliconValley/Vista/2207/sql1.html 
 

Connection – This is a drop down box allowing you to select which connection you 
are querying. You should have already created a connection before adding a query 
to the layout. In the example above the ‘Connection 1’ connection has been used. 
 
Multiple Records – This is a drop down box allowing you to define what happens 
when a query to a database produces multiple results. It is possible to ‘Use the First 
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Record’ or ‘Show Record Selection Screen’. If showing the record selection screen 
then all returned records are displayed on screen and the user can select which 
record is to be marked. A typical application may be to display all records of the days 
production which have not already been marked. The user can then select the next 
priority job from all jobs available, rather than marking each job in sequence, as 
would be the case if ‘Use first record’ was selected. 
 
Name – This is the name given to the query. This name will be used when linking 
marking objects, such as text to be marked in the layout to the records returned from 
a specific query. The default name is ‘Query 1’. It is possible to have multiple queries 
in a single layout. If this is the case then each query will need a different name. 
 
Query – This is where the query is defined. An SQL statement should be inserted 
here. Each statement will be specific to the database being queried and the data 
required from the database. In the example above the query is searching for all 
records from an Excel spreadsheet with a sheet name of Sheet1 which have not 
already been marked. Below is an example of the excel file. 
 

 
 

 
Select * from [Sheet1$] where Marked is null; 
 
Select  from    where  is equal to 
 
 Everything Sheet1 in spreadsheet Marked column empty 
 
This query would return 7 records from the above excel spreadsheet as the first 2 
records have a value in the Marked column. 
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Query Option – This is a drop down box with 2 options. ‘Stop if no Records Found’ 
and ‘Stop if Records Found’. If you are querying for data to be marked then this 
options should be set to ‘Stop if no records found’. If, however, you are performing a 
duplicate check to see if a serial number has already been marked then you should 
set this to ‘Stop if records found’. 
 
Unique ID and Unique name – These properties are used by external programs 
and do not need to be modified. 
 
 
Marking the Query Results 
The query will return data from the spreadsheet or database. To actually mark the 
data returned it is necessary to link the text object in the layout to the database query 
results. This is achieved by setting the mark text to a database link command. For 
example if we wish to mark the Serial Number and Data fields from the above excel 
file and we have used the Query called Query1 above we must set the text on our 2 
text objects to… 
 
Text Object 1 = [db:Query1.Serial] 
 
Text Object 2 = [db:Query1.Data] 
 
Text Object 1 will mark the returned data from the Serial column in the spreadsheet 
(e.g. ‘4’ from next available record in spreadsheet on previous screen) and Text 
Object 2 will mark the returned data from the Data column in the spreadsheet (e.g. 
‘1.6L’ from next available record in spreadsheet on previous screen). 

 
 
 
When the layout is marked the software will execute the query and replace the text in 
the layout with the results of the query.  
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Using the Database Test Dialog to test the Query 
The database test dialog is a useful tool to test the SQL syntax and view the records 
returned from a database. Select Tools->Database Test Dialog from the menu and 
select the Query tab. 
 

 
 
The SQL statement is displayed. In the example above the software will select all 
unmarked records from Sheet1 of the excel spreadsheet. Click Execute and the SQL 
statement will run. If successful a message box will display how many records have 
been returned. 

 
 
Click OK and the results will be displayed on the Database Test Dialog as below. 
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This proves that the SQL statement is correct and that the results are the 7 
unmarked records from the total 9 records in the spreadsheet shown on the previous 
pages. 
 

Next Record Object 
The next record object is useful when multiple records are returned and multiple 
parts are marked in a single layout. For example if 3 components of the above 
example are to be marked at the same time. Then adding a next record object 
between text objects will cause the software to take the next record of any multiples 
returned and apply the results to the next text objects. See the screen below, notice 
the 2 next record objects in the marking sequence. 
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Based on the excel spreadsheet example on the previous pages this will mark 
 
4 
1.6L 
 
5 
1.9d 
 
10 
2.0TDi 
 
 

Execute SQL Object 
The Execute SQL object allows an SQL statement to be executed at any stage of the 
marking process. This feature is most useful for writing data back to a database 
using the ‘Update’ SQL command. To add the Execute SQL object to the layout 
select Insert->Database->Execute SQL from the menu.  
 
In the example below the Execute SQL object is used to write back to the database 
that the record has been marked. This, combined with the previous Query object 
which checks if it has been previously marked, prevents the same record being 
marked twice. 
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It is recommended that you use the Database Test Dialog when adding ‘Execute 
SQL’ objects to the layout. Once the object has been added to the layout open the 
Database Test Dialog from the Tools menu. 
 

 
 
This update command will write back to the database a value of ‘1’ to Sheet1 of the 
excel spreadsheet on the adjacent column called Marked where the Serial column 
matches the serial data just marked (like the serial values 1 and 2 in the excel file 
featured on the previous pages). 
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update [Sheet1$] set marked=1 where serial=@serial; 
 
Update Database       Write Back  Where  Serial column  
 Sheet1 in Spreadsheet      a ‘1’ to Marked column  is equal to last query  
 
This example only wants to write back to the record which has been marked. To do 
this we have chosen a unique field in the database. In this case it is the Serial 
column (all numbers are unique). We only want to write back to the record where the 
Serial value in the spreadsheet matches the Serial value just marked. To do this we 
need to create a parameter to feed into the SQL statement. This is where the @ 
character is used. 
 
To add parameters click on the Parameters tab on the Database Test Dialog. 
 

 
 
In the example above the serial parameter has been given the value 
[db:Query1.Serial]. This is the same value as the marked text object. It is therefore 
assigning whatever was marked on the layout to the ‘serial’ parameter. This 
parameter can now be fed into the SQL statement by adding an @ character to the 
beginning of its name as in the example above. 
 
Using the Database Test Dialog it is possible to Execute the SQL statement to test if 
it is correct. In the case above the [db:Query1.Serial] value is unknown because this 
query has not yet taken place. So to test this, replace it with a known value eg 10. 
Then press execute. The spreadsheet now has a 1 written against the 10 serial 
number in the Marked column. 
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Sample Database Files 
The MarkMaster software installation program also installs some sample layouts and 
sample database files to illustrate the Database features. The files are located at the 
path. 
 
C:\Program Files\Pryor Marking Technology\MarkMaster\Samples 
 
 
DatabaseExcelSample Sample Layout 
The DatabaseExcelSample file connects to the Example.xls file also located in the 
Samples folder. This layout will start at the top of the excel spreadsheet and mark 
each entry one at a time until all entries have been marked. This example file makes 
use of the Connection, Query and Execute SQL objects. Experiment with the 
Multiple Records property on the Query object with this sample. 
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DuplicateCheck  Sample Layout 
The DuplicateCheck layout marks an automatically counting serial number. The 
database features are used to search the database to see if the number has already 
been marked. If the number is found in the database an error message is displayed 
and the mark is prevented. If the mark is successful the layout will write the marked 
serial number and time/date stamp to the database to prevent it being marked again. 
This example uses an Access database called Sample.mdb with a table name called 
DuplicateCheck. Note: It does not need to be an automatically counting serial 
number which is duplicate checked. The layout could easily be modified so this value 
is manually entered. 
 

 
 



 Markmaster user guide 

 

 8-13 

 
 
Lookup Sample 
The Lookup sample layout connects to an Access database called Sample.mdb. 
When the layout is marked the user is prompted to enter a value between 1 & 10. 
When the value is entered the Query object searches for the entered value in the 
Value column of Lookup table in the database. It then returns a single record which 
is linked to the text object in the layout and is ultimately marked.  This is a good 
example of database searching based on a user input. Pay attention to the 
Parameter tab on the Query tab of the Database Test Dialog. 
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SECTION 9  
CIRCUMFERTIAL MARKING  
 
If attached, the circ axis fixture device settings can be accessed and enabled via Mark, Device 
Settings. Elements are marked on a circ axis by overlaying a marking area on top of a standard 
layout, as shown below 

The circ marking area is shown as a series of blue and grey bands, representing the individual 
marking areas that the marking head will cover. The head will effectively mark the first segment, 0-
30º, then reposition itself as the circ rotates to the 30º-60º segment, mark that, etc. Hence the 
representation on screen is of the surface of the cylinder being marked – imagine peeling off the label 
wrapping a tin can and laying it flat. For this reason it can extend outside the apparent layout 
boundary, as can be seen below. 

The circ area can be selected and dragged around the layout. This simulates moving the circ fixture 
around the marker base plate. A part with numerous diameters can be marked by adding a number of 
circ marking areas next to each other (working to the right) and setting their diameters accordingly.  

 

 

All standard elements can be added to the circ layout area as shown in the example below. It is 
important that the marked element sits below the circ part in the marking sequence or they will be 
treated as standard flat part marks. Also the element should not extend outside the circ marking area. 
The two elements marked ‘Truncated’ will be. 
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It is important to note that marking will start from the 0º position, so in the example above, the ‘Vertical 
text’ mark will be made first. As the circ rotates, the two ‘Truncated’s will be marked, then the Data 
Matrix at the top etc 

The example below shows how to handle a long string of text that ideally starts from the 0º point for 
fastest marking. As the text will not fit, it must be moved ‘up’ the circ part to fit, leaving its start point 
around 270º. On marking, the circ would rotate through ¾ of a turn before starting, then mark through 
approx 180º as the text was marked. At best this is slow, at worst it could run up against a proxy that 
disallows marking past 360º. 

A rotational offset can be applied to allow for this. In the example, the text will start at 270º so an 
offset of -270º has been applied to negate this. Marking will begin at the 0º position.  
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Indexed marking 
 
The examples above assume a smooth circular part. To mark items with flats, such as nuts, indexed 
marking can be used. The example below has indexing turned on and is marking a 6 faced part. A 
3mm Z backoff has been applied that will lift the head away from the job as it rotates, to avoid hitting 
the face edges as the nut rotates. 
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Axis homing 
 
The circ can be set to home before, after or both before and after the mark, if a proxy is enabled. 
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Settings 

 
 
Name  
Appears in the layout, doesn’t have to be unique but is advisable 

Diameter  
Of the part to be marked 

Segment size (deg) / Segment count 
Related, setting one will amend the other. Limited to max of 200 segments (1.8º) 

Rotation offset (+/- deg) 
Fastest marking will always be achieved when the marked elements are positioned at or near 0º. If 
this is not possible, setting this will reposition the effective start point as explained in the example 
above 

Indexed  
Turn on to mark parts with flats, such as nuts 

Z backoff each segment 
Lifts the head to clear any edges when turning a nut for example 

Demarcation / Indicate degrees/index no 
Allows user control over how the circ part marking area looks on screen 

X Axis / Y Axis 
The centre point of the circ marking area on screen. Marked with a small blue cross 

Width 
The width of the circ marking area on screen, which will probably be matched with the part to be 
marked (or a significant portion of it) 
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SECTION 10  
RS232 CABLE DETAILS  
 

 


